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GeneMarker Manual

General Overview

Main Analysis Window

There are four major displays in the main analysis window.

Navigator; Sample File Tree
Electropherograms
Report; Report Table
Project Summary

See Helpful Icons Index for further details.
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Navigator; Sample File Tree

This view lists all the samples that are included in the project. Prefixes LD, PC and NC are labeling the
allelic ladder, positive control and negative control

The sheet icon to the left of the sample name indicated the quality of the internal lane standard (ILS) with
the following color/code:

i. Green = High Lane Quality; Passing Size Standard B
ii. Yellow = Requires Verification
iii. Red strike through = No Sizing Occurrence; failed to callsize

iv. Red Question Mark = one or more quality criteria are'not met.baseéd on the analysis
parameters; See Quality Reason Index for more details.

Project Summary

This bar located at the bottom of the main analysis screen summarizes the project as well as alert the
analyst to samples that did not pass analysis parameters.

MNew 22 samples PCerrar il NC erramia/3 Ladder error: 0/1 Fhailed=1 #Hagged=19
1. New reflects the data set is not a project that has been previously analyzed.

a. If the first column read Modified, the project was previously analyzed in the software.

2. The second column denotes the number of samples (including controls) contained in the data
set,
3. Columns 3¢5 indicate the number of controls in the data set that do not meet the quality

criteria set in the software. See Quality Reason Index for more details.
4. Column 6 denotes the number of samples that were disabled.

5. Column 7 denotes the overall number of samples, except the allelic ladder, that do not meet
the quality criteria set in the software. See Quality Reason Index for more details.

NOTE: Flagging features are an indication of potential failures. The ultimate decision of
passing/failure is made by the analyst after further evaluation.
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Calibration Chart Window

There are three major displays in the calibration chart window.

1. Sample List
2. Size Standard Template
3. Sample ILS

| 4% Calibration Charts

W e

=ik SES H-~ ¥ Help
Expectad Size - 15500
- o 20 40 60 B0 100 120 140 160 180 200 220 240 260 280 300 3200 340 360 380 400 4200 4epf 4E0 430 500 E30 540
33 e4-alelic_Ladde 57 !
34 634M2_C2_500 - 8 100
35 62442 C2_500_ 57 a0
35 61M2C2 500_15-1.. 97
37 60M2.C2 500 20-1.. 97 E
38 59M2C1750_1-20.. 97 @
33 58M2C1750_1-15.. 98
40 STM2CI7S0_1-10.. 97 20
4 S5M2_C1750_ 57
42 55M2_C1750_ 8 e
43 54M2_C1750_ 57
@ mmcomai. o ] U B vt o J—-
% siMZCITs_L. 7 65 80 100 120 140 160 180  200,40\22 250 2fSp. 300\ 4325 350 375 400 425 450 475
4fa S0MZC1750_15-L.. 97 <00
494\4“2Tcu;§,zu-1.” 8 v v v v
48-Allelic_Ladder 3 H... 97 300
47M1.C4 100_1-20... 98 vy ¥ ¥y v T ¥ A v v M M M H
46-M1_C4_100_1-15. a7 200 A “
45M1C4 100_1-10... 97 100
44M1C4 100_14... 98
434M1_C4_100_ 97 0 y N L
42-M1_C4_100_ 8
:ém—g:—:gg- g; 3,500 4,000 4,500 5,000, 5,500 €000 6500 7.000 5 =00 9,000 9,500 10000 10500
o B Ca 00 101, 98 | | F3IMIC3_250_14 6M_22F _ADS 00Lfea 3244003 250 _1-2_6M_22F HO4ID 15 s 250_1-1_6M_23F_GD4_014.fea P
59 38M1_C4 _100_15-1.. 97 s | U === sgof A Q. . i : :
60  37-M1C4 100_20-L.. 97 '
61  35M1C3 250 1-20... 98 400 a0}~ : 400
62  35M1C3 250 115.. 98 7 0 I
63 34M1C3 250 110... 97 &3m0 a0 300
64  33M1 (3250 14.. 97 ] : P
T EN IR | @ 200 | (@200 - @ 200
66 31M1C3250_1-1.. 97 : :
67 30-Mi_C3_250 21, 8 100 GORGIECRRIISRREE. NGk e rmnnne = L R AL RRLE L L SR 100
68 25-M1C3_250_ 8 ; : ; : ; ; ; : ; ; ;
68 | 28-M1 C3 250 &7 4,000 6,000 8,000 10,000/ 4,000 6,000 3,000 10,000 4,000 6,000 3,000 10,000
70 274M1C3_250_15- 8 Frame Frame Frame
71 26-M1C3 250_20-L.. 98 50-M1_C3_25048-1 6M_22F_FO4\012\ fsa 28-M1_C3_250_10-1_6M_22F_D04_008.fsa
72 25-aldic_Ladder_2 A... 98
73 24-Amplifica 1 |2 00
74 23M1C2 500_1-20.. 97
75  22M1_C2 500_1-15. a8 L. a0
76 21M1C2 500_110.. 97 Z
77 204M1C2 500 14.. 97 2300
7 _ 5
79 - @ 200
80 : : : :
81 I| 100 : : . :
82 T T g T T T g T T T T T
83 4,000 6,000 8,000 10,000 4,000 6,000 8,000 10,000 4,000 6,000 8,000 10,000
84 Frame Frame Frame
85  12M1C2.500 20-1... 97| 27-M1.68 250_15-1 BMU2eF_C04 006.fsa 26-M1_C3_250_20-1_6M_22F_B04 D04.fsa 25-Alleic_Ladder_2_AD4_002.fsa
8  11M1C1 750 120... 97
87  10M1C1 750 _115.. 97 Eo0
88 09M1C1750_110.. 98 -
8 08-MIC1750_14 97 5
S0 07MiC1750_12 57 S0
91 06M1_C1750_ 97 -
92 05Mi_C1_750 21, 57 o0
-3 n4wmiiciizs0’: 8 :
34 03MICI750_ 57 100
=5 ozMicirs0_15-L. 97 : :
9 0LMICL750 20-L.. 98 T T T T T T T T T T T T
4,000 6,000 2,000 10,000 4,000 £,000 2,000 10,000 4,000 £,000 2,000 10,000
q i D Frame Frame Frame -

Sample List

This view lists all the samples that were processed in the project. The Score column represents how well
the size standard template and the sample ILS match. The closer the score is to 100, the better the match.
The sample may fail automatically if the size standard is bad enough, or may have to be failed manually
by the analyst.
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Size Standard Template

The template highlights all the peaks that should be labeled in the corresponding sample ILS for easier

comparison.

Samples ILS

The sample ILS displays the peaks that were detected. As well as the approximate start'ef the data
analysis view, indicated by the dash line.

All Color Browser Window

There are four features in the All Color Browser that allow for straightforward review of the sample.

Mo

Sample Drop-Down
Max Chart Number
Scroll Within a Sample
Scroll Between Samples
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Sample Drop-Down

The sample drop-down lists all the samples within a project. A user can move between samples by
clicking on the sample name instead of scrolling through all electropherograms.

Max Chart Number

Max chart number views each sample by the number of dye lanes as per the user’s needs,during sample
analysis.

Allele Labels

When analyzing samples in the Main Analysis window @rthe All Color Brower window, alleles maybe
colored yellow or red.

| THO4 | | D1asay || “Diess3en | | 0251338 |
160 180 200 220 240 260,280 300 320 340 360

NI - A NTENT

7 e | 15

175.0 HE 6 26851 31948

316 5453 5106 5942
3 11 11 21
1829 2285 2762 3325
5356 0 TE74 G007

This indicates that @ne or more quality criteria have not been met in the software. See Quality Reason
Index for more details.

NOTE: Flagging features are an indication of potential artifacts and/or allelic imbalance, or peak
saturation. The ultimate decision of passing/failure is made by the analyst after further evaluation.
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Peak Table

When analyzing samples in the Main Analysis window or the All Color Brower window, a peak table
maybe added to supplement analysis by clicking Show Chart/Table icon
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1,000
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B0
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4001
300
200

[ 0851173

021511 | [ Dvsszn

| [Seio ]

100 150

200 250 a00

350

M

[11,274.9.456] [12329:3702]
Mo, | Dye Size HagWarkel l Allele Guality Score | Allele Comments Guality Rea...
1 Blue 95.7 176 97y Undeter.. 1.3 oL
2 Blue 1437 1153 DSSTI?S 13 Pass 121.7
3 Blue 2078, 828 D215H, a0 Pass 100.6
4 Blue 270, 8_r821 D?SE2EI_ 10 Pass 46.1
5 Blue 2749 456 D7sa20 11 Pass 271
& Blue A1 ? 154 £ " CSFIED 10 Pass 971
7 Blue 3293 020 CSFIPO 12 Pass 485

This table will indicate to an analyst which alleles were flagged and which quality reason was triggered.
See Peak Table Options Index for further details.
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1. Load Data

1. To start your project, go to File — Open Data — Add

I Navigate to the network folder containing the data files (i.e. the .fsa files) to
be analyzed.

ii. Select files to add (include only one ladder pef. project)
i. Hold Ctrl key to select multiple files
ii. If analyzing all files hold Ctrl ahd A keys

iii. Select Open
I. Ensure correct files are,added touist

iv. Deselect Auto-Elevate

Open Data Files g|

ta File List:
SRunsh D28 mistureshBun HS1 2007-00-28 1713833 AL fza &4 »

SRungh D28 misbures \Bun_HS1,2007-01-26_113434-_pe.fza
YRunshID2E mistures\FBun HS1 2007-01-26_113435_pe2 fza
YRun_HS1, 2007-01-26_113436-_Buccal_27-28 1-5bfsa
WRun_HS1 2007-01-26_11 337 _Buccal_27-28 1-5c.fsa

Mo

b

b

g

M -_|
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b

Ao

b

b
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=
&
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=

ﬁ Cha ds..| [ AutoElevate Ok | Cancel ‘

V. Select OK

2. Ensure that prefixes LD, PC and NC are labeling the allelic ladder, positive control and
negative control, respectively, in the Sample File Tree.
i. If they are not, right click on the sample name in the Sample File Tree —
Set Sample Type — Select appropriate sample type
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3. Click Run Project located in the top toolbar. -

I1l. Run Wizard

1. In Template Selection window, select the appropriate existing template.

a. Yfiler® LIZ

Template Mame: |YFiler

Panel |Yfiler_OGME =M=
Size Standard: [LLZ_Yfier = i
Standard Colargy) OFANGE |
AnalysigType: [HID |

b. PowerPlex Fusion® LIZ

Template Marme: |Fusi|:|n

Panel: |Fusi|:|n_OCI'~"IE_n|:| filter jHEI

Size Standard: |I|_5 500 j M
Standard Color: | ORANGE |
Analysiz Tope; |H||:| J

2. Click Next
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3. Inthe Data Process window, ensure the following settings are used based on amplification

kit.

a. Yfiler®

Run Wizard

Data Process - HID Analysis
Set data process options

Faw Data Analyziz
[ Aubo Range [frame)

Start: (2300 &

[v Smooth

1
End: [9000 %

|~ Enhanced Smooth
Bazeline Subtraction:

[~ Superior ¥ Clazzsic [ Enhanced

[v Pull-up Comection v Spike Removal

[ Saturation Repair

Size Call

(+ Local Southern () Cubic Spline

Eisave |

o N\ 1=

Allele Call v ) 4
| o Auto'Range [bpz)
Stat: |75 %  End [410 %]

Peal. Detection Threghold: j

Minlbtenzity: |75 =1 MaxIntengity: (20000 45
Percentage > |8 | Global Max

Mote: Use Fanel Editor to set Min Intensity
and *: Global Max for peaks within Markers

<< Back |

Mest > |

LCancel
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b. PowerPlex Fusion® / PowerPlex Fusion® STRmix™

Run Wizard

Data Process - HID Analysis

Set data process options

Raw D ata Analysiz
v Auto Range [frame)

0

¥
bl

v Srmooth

Bageline Subtraction:
[v Superior
[ Pull-up Carrection
[ Saturation Repair

| Classic

ta
10000 &

[~ Enhanced Smooth

[~ Enhanced

Iv Spike Remowval

Allele Call
[~ Auto Range bps)

Start: |55 .,3 End, 5107w

Peak. Detection T hreghold: il

bin Intenzity: (50 vﬂ b & [pkenzity: | 32760 5
Peigentage > |0 »| Global Max

Maotesl)se PanelEditor to set Min Intensity

4
| and *2Global Max for peaks within Markers

Size Call
{* Local Southemn " Cubic Spline | |
& save | [ie ‘ << Back, Cancel
4. Click Next
5. In the Additional Settings,window, ensure the following settings are used.

\'%

Allelic Ladder:

Fusion — Auto Select Best Ladder is Checked

Y Filer — Auto Select Best Ladder is Unchecked. Select Ladder for analysis
from drop down box.

Auto Panel Adjustment: Box is checked

Select the Positive Control Template using the Positive Control drop-
down.

For Yfiler® Yfiler MPC

For PowerPlex Fusion® PP_Fusion

Under Allele Evalution Peak Score, Reject 0.00 and Pass 1.00
Deselect Mixture Evaluation

Note: Do NOT click Save within the Data Process Window. This will

overwrite the tem

plate for all analysts.

6. Click OK — Once data has finished processing Click OK
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7. On the top left corner of the screen, Click File — Click Save Project — Navigate to desired
folder and save project using current naming system (i.e. Newton090615 8-11U A)

IV. Checking the Allelic Ladder

1. There are two areas in the Main Analysis window that indicate if the allelic ladder,used for
analysis has passed.

a. Inthe Sample File Tree, a red question mark nextto,the allelic ladder would indicate a
potentially failed ladder.
b. Inthe Project Summary, a ladder error would indicate a‘poeténtial failed ladder.

2. Visually confirm all expected alleles in the allelic ladder-are present. This may be done in the
Main Analysis Window or the All Color Brewer.

3. If the ladder used for analysis failed, elick Eile from the menu bar - Click Open Data -
Highlight the failed ladder from.the Data File List > Click Remove - Click Add... - Navigate
to the .fsa files > Select a different ladderfer analysis - Click Open - Click OK. Return to
Section Il. Load Data, step 2 and proceed.

V. Checking the SizeStandard
[]

1. Located on the topitoolbar in the main analysis window, Click Size Calibration

2. Inthe Calibration Charts window, Click Chart Synchronize

3. Click Sample Name header to sort samples in order. In the Sample List, either Click on a
Sample or Navigate using the Up/Down Arrows, check the size standard for each sample as
per the amplification kit.

a. If the peak is recognized by the software, a green inverted triangle appears at the top of

the peak. v

b. If the size standard needs manual editing by adding or deleting a peak; Right Click on
the desired peak — Select Delete/Add Peak — Right Click Again — Select Update
Calibration
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c. Ifasize call fails, in the Sample List, Right Click on the Sample Name — Select
Mark as Failed.
d. Close Calibration Charts window.
i. Ifany sample was marked as failed a rerun code must be applied to that sample.
Right click on sample in Sample File Tree within Main Analysis Window >
Click Edit Comments - Enter rerun code in Comments field > Click OK

4. In the Main Analysis window, Click on the Down Arrow nextte,.the Show Color icon

located in the top toolbar. — Click Hide All

5. Inthe Sample File Tree, Right Click on Allele Call —€licksSelect Max

6. Inthe Main Analysis window, Click on the.Down Arrow nextto the Show Color oA icon
located in the top toolbar. — Click ORANGE

7. Adjust axis to view size standard depending on.amplification kit
Y,
a. On the top toolbar, Click Set Axi§icon _x
b. Click Fixed ‘X’ — enter X axis range
i. Yfiler® = 75-410
ii. PowerPlex Fusion® = 55-510

c. Click Set Axisiagain'=> Select Auto Fit Y

Note: Analysts can zoomrin/out by using the zoom icons N located at the top toolbar. In
addition, hold dewn left buttomon mouse and drag the dotted box that appears from the upper left to the
lower right (around the'desired “zoom in” area). To zoom out, hold down left button on mouse again
dragging box from lower right to upper left. To scroll while zoomed in, right click and hold while
dragging the mouse.in the direction you want to scroll.

8. Review size fragments by ensuring that all required peaks are labeled within +/- 0.5bp of the
fragment size.

a. |If apeak is not labeled, then the size standard fails. Go back to the Calibration Chart
window. In the Sample List, Right Click on the Sample Name — Select Mark as
Failed.
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i. Ifany sample was marked as failed a rerun code must be applied to that sample.
Right click on sample in Sample File Tree within Main Analysis Window >
Click Edit Comments - Enter rerun code in Comments field > Click OK

Size Standard

Yfiler ®
i Yfiler® samples are run with L1Z 500. The LIZ_Yfiler size template fordC1Z'500,does not have the
250 bp sizing peak labeled as it is not utilized for data sizing. All othér size calls inithe range of 75-
400 bp peaks must be properly match scored/sized
ii. When viewing the size standard in the orange dye lane, the 250bp will be labeled<This peak is not
being used for sizing.

75 100 139 150 160 200 300 340 4350 400

£,000
¥y v 7 ¥ ¥ ¥y 7 ¥

v

4,000 v

2,000 ”

0 . _ -a

T T T T T T T T T T T T T T T T T T T T T T T T
2400 2600 2300 3,000 3200 3400 3600 3200 4000 4200 4400 4600 4300 5000 5200 5400 5600 5300 6000 6200 6400 6600 6800 7000

PowerPlex Fusion®
i PowerPlex Fusion® samples areyrun with the WEN I1LS500. ILS500 has a range of 60-
500bp(Fragments: 60, 65,80, 100, 120,140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400,
425, 450, 475, 500). All size fragments‘must be labeled in the calibration chart and the orange dye

lane.
G065 80 100 120 140 160 180 200 225 250 275 300 325 350 375 400 425 450 475 500
800 | v
800 ] | A v 1 T
400 I Yy v Yy v v Y ¥ L B { ¥y Y 7 ¥y v 7
200 | |l " ﬂ—
od | S
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2,500 3,000 2500 4,000 4,500 5,000 5,500 6,000 6,500 7.000 7,500 8.000
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V1.Analyzing Samples

Analysis of the data can be performed in the Main Analysis window and/or the All Color Browser =
window.

1. Adjust axisto view samples depending on amplification kit
Y
a. On the top toolbar, Click Set Axis icon lé(
b. Click Fixed ‘X *> — enter X axis range
i. Yfiler® =90-340
ii. PowerPlex Fusion® = 55-510
c. Click Set Axis again — Select Auto Fit' Y

Note: Analysts can zoom in/out by using the zoom icons e located at the top toolbar. In
addition, hold down left button on mouse and drag-the dotted box that appears from the upper left to the
lower right (around the desired “zoom in” area). To zoom out; hold down left button on mouse again
dragging box from lower right to upper left.“Te scroll while,zoomed in, right click and hold while
dragging the mouse in the direction youswant to.scroll.

2. If using the All Color Brower window, adjust Max Chart Number to 2

3. Analyst may chogse to use the Peak Table 1 icon to turn the

chart/table on and, off.

4. Editing@peak
a. Click'omPeak to Highlight — Right Click— Click Edit Comments— Select Edit
From List or Type New Edit (refer to edit code list) — Click OK.
b. To'select multiple peaks for editing, Hold the Ctrl key + left mouse click — Drag the
mouse to highlight intermittent peaks
c. Once the correct Edit is selected, highlight the peak and press Delete key to remove the
peak.
d. To check peak history = Right click on peak - Click view history
i. Any changes made to the peak will be listed in order from most recent down.
Click on any line to view specific change details in the Current/Old Values:
window. Scroll all the way to the right to view edit code applied to peak in Allele
Comments column.
Note: If a peak is deleted and needs to be undeleted, Click on Peak to Highlight — Right
Click—Undelete. If an edit needs to be removed from a peak - right click on peak = click edit
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comments > remove text from Comments: box so the text field is blank = Click OK (the E will still be
visible but the edit comment will be removed)

Note: +/- 4 stutter should not be manually edited from evidence samples in Fusion. This edit is only to
be used in positive control samples, exemplar samples, and Yfiler.

5. Scheduling Re-Runs
a. If sample Failed (over saturation, bad size standard, etc..) = Right click,on sample in
Sample Tree within Main Analysis Window > Click Disalile > Type Re-Run Code in
the comment box - Click OK
b. If sample did not fail but re-run is desired = Right click on sampleinSample Tree
within Main Analysis Window -> Click Edit Comments 2 Type Re-Run Code in the
comment box = Click OK
6. Over- Saturation
a. Check for saturated samples = In thedMain Analysis Window electropherogram a pink
line will indicate the possible saturation,of peak.Fhis indication will also be noted in the
Peak Table as <SAT> for that allele,in the*Allele Comment field. If the sample has
excessively saturated peaks (>10,000 RFU or split peaks) this sample must be rerun at a

dilution.
06-2ng_DNA2c_F01_011.fea (06-2ng_DNAZZ) (ReFLaAder: 08-Alleic Ladder_1_HO1_015.fsa) 3
| Des1179
THO1
D165538
AMEL
78 78 80 a2 B4 85
5,000
4,000
3,000
2,000
1,000}
0 =
4754
ikl =
82.2
5086
80.0
80.0
209
Mo, | File Name Size Heigh§ | Allele Quality Allele Comments Sample Comments Qui #
1 05-2ng_DNAZC F... 789 4754 X [<5AT=] s
?  05-Zng_DNAZC F.. 1247 387mf 16 Pass
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7. Once the entire run has been reviewed, all edits have been made and all edited peaks have been
deleted, on the top left corner of the screen, Click File — Click Save Project
a. You must save over the existing project every time you save

VIl. Exporting for LIMS (all systems and sample types)

1. Inthe report display section of the main analysis screen, click onthe arrew next tg the Save

Report icon = - . Ensure the “Save LIMS report” is selected.
a. Inthe LIMS report settings window that pops up; ensure the settings are as follows:

The Size Range will be the same as the X- axis range for analysis:

90-340 for Yfiler and 55-510 for Fusion.

[ LIMS Report Settings ‘v ‘@

Diypes Dptions G

v BLUE v RED

v GREEM

o u Figm_|55 to {510
v VELLOwW, |

| | [ Abide By Panel

— [ Grouped By Markers

lv Show File Mame
| Columns. ..
[ Show Samples ame
W Show Deleted Peaks > [«
[ Hide Extra Sample'™ames [ Show Only Uncertain Alleles
[ Exchlude Report Header [ Show Rejected Low Score Alleles

Ok Cancel

b. In Options, click on “Columns...”; use the Add/Remove buttons to ensure the Selected
Columns are present and listed in the order that follows:
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Selected Columng

Plate 1D

b arker

Dye

Size

Allele

Allele Comments
Sample Comments

This is crucial to proper LIMS importation.

2. Click OK; Click OK again in the Allele Report Settings'window. Save thie file as type “Excel File
(*.xlsx;*.xls)” under the appropriate run name (make sure to delete suffix “_AlleleReport”).

VI1Il. Exporting Electropherograms,(all system and sample types)

In the main analysis window,

Click Set.Axis = Click Fixed X axis The Size Range will be the same

as the X- axis range,for analysis:
a. 90-340for Yfiler
b. 55-510 for Fusion
- SelectAuto Fit Y

1. Click Tools=> Export Electropherogram
2. 'Set'Qutput Folder to desired location for project PDFs by clicking J icon

(3]

Export Electrophercgrams

Output Folder: |M:HSTFE_D atahilA_OCsAthena\ 207 65NAthenal31416_10-11_2016-03-14% J

3. Ensure settings match below: Make sure to select PDF as export format
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Select Diyes

v| BLUE

v GREEM

| TELLOW

v RED
ORAMGE

Dye Image Size

width, | 1024 pixels J

Height: |700 pinels |

. U -

| Orne image pes anmple
v AutoSgale Size Range
I Auto Scaled arker Intensity

Expaort Fafrnat: | FOF file - |

4. (In'the suffix field enter the run name with a “ ” before it. (Ex: _Newton061316 88-89)

5. Printing the ladder: Right click in the sample list = click Deselect All - Check the box
for the ladder - In prefix field enter ladders_ - click Export

6. Printing the controls: Uncheck the box for the ladder and check the box for all controls in
the run = In the prefix field enter controls_ - click Export

7. Printing the samples: Right click in the sample list = click Select All > Uncheck the
box for all ladders and controls in the run and any samples that were disabled or failed,
leaving only the passing samples = clear the prefix field = click Export. This will
create 4 PDFs for every sample, one for each dye.

8. Import all PDFs into LIMS.
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IX. Fusion Exemplars Only - Exporting EXEMPLAR table for
STRmix™ input (for evidence table instructions see section
XI1)

1. In Main Analysis Window Click H - icon - Select Show All. In the report display

ﬁl.
section of the main analysis screen, click on the report séttings icon . Make sure
settings match below:

Allele Report Settings @

Repart Style O ptions —l
" Allele List [ Extend Diploid Homozigos

(¥ Fn:nrensn::& [v Show Allele Mame |
" Bin Tahle [v Show Size [0.1bps)

" Peak Table v Show Height

7 Allele Count [ _shawdea

[T Show Scare

- She [

[ Show Only Uncertain Alleles

[v Show File Mame

[ Show Sample Mame

Urientation 7 v Shaw Rejected Low Scare Alleles

i~ Haorizontal f+ ‘Wertical

[ Hide Extra Sample Mames

[ Ewxclude Sample)ndes [ E=clude Report Header

Ok Cancel |

2. Inthe report display section of the main analysis screen, click on the down arrow next to

the Save Report icon " . Ensure the “Save Report” is selected.

3. Navigate to appropriate folder and save file as “Run name SM”

4. For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.
Open the exported project excel file from Step 1 above.
Open GeneMarker® to STRmix™ macro.
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Follow the instructions on the “instructions” tab.
After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.
Change the file type to “.txt” (text, tab delimited)
Navigate to folder containing your project data and save file there.

X.  Fusion Evidence Only - STRmix™ Analysis(stutter filters

off)

1. Begin by importing the data from the initial analysis into LUMS to generate the edit sheet.
Have the edit sheet open in LIMS as you perform the seeond analysis withsstutter filters off
for STRmix™ to refer to and ensure the same edits are being.made the,second time.

2. If Project is still open = Click Run Project | » located inthetop toolbar.

a. If project is not open - Click File =, Open‘Project > Navigate to run -> select
project > click open = Click Run | g, ot

located in the top toolbar.

3. In Template Selection window, select the appropriate existing template.

4. Click Next

Template/Mame: |Fusi|:-n_STRn1'x

Panel: |Fusiah OCME_STRmix_No ~ | HEI

Size Standard: ]ILS 500

=]

Standard Color: | ORANGE

=}

Analyziz Type: |H|D

E2

a. Inthe Data Process window, ensure the following settings are used based on
amplification kit.
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i. PowerPlex Fusion® STRmix™

Fun Wizard

Set data

Data Process - HID Analysis

Raw Data Analysis Allele Call =
v Auto Range (frame) E [ Auto Range [bps]
b= 10000 5 sta: [55 3] gBnd [S10 %
b Smoath [ Enhanced Smooth Peak Detection Threszkold: ﬂ
Bazeline

Iv Superior | Clazsic | Enhanced

| Pullup Corection v Spike Remowval
[~ Saturation Repair

=

process options

ST o Min Intensity: [50 ] e Intensity: [32760 =
Percentage > |0 = | Globalddax

Mote: UselRaneEditor to set Min Intensity
and % Global Maxior peaks within Markers

Size Call 1
* Local Southern " Cubic: Spline
& 5ave | =lete << Back Cancel
5. Click Next

6. Inthe Additional Settingswindow, ensure the following settings are used.

a.
b.
&,

d.
e.

Make sure Auto Select Best Ladder is selected

Auto Panel Adjustment: Box is checked

Select thePositive Control Template using the Positive Control drop-down.
i. ForiPowerPlex Fusion® PP_Fusion

Under Allele Evalution Peak Score, Reject 0.00 and Pass 1.00

Deselect Mixture Evaluation

Note: Do NOT clickSave within the Data Process Window. This will overwrite the template for all

analysts.

7. Click OK = A window will pop up:
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[ Use OId Calibration ==

& Size Calibration

The internal lane sizes hawe been calibrated in the samples.
“'ou may check Call Size Again to recall the sizes.

¥YWhat to do:

Apply to Al Apply to Current

Check “Call size again” and Click Apply to All'>. Allow,data to process — Click OK

8. On the top left corner of the screen, Click File,— Click Save Project = Save Project with
suffix _SM

9. Perform a second analysis of thisfrun

a. Do not recheckor edit Ladder, Size Standard or Controls. Passing controls and
size standard are determined by the initial analysis.

b. InSample Aree > Right click and disable every control in the project except the
Ladder.Enter Comment “Not Used”

Cn, Delete theisame peaks that were edited and deleted from the initial analysis. It is
notinecessary to enter edit codes again.
Ensure any sample that failed initial analysis is disabled.

e. \If a sample had a rerun code during the initial analysis it is NOT necessary to
enter the rerun code again.

10. Once the entire run has been reviewed, and all artifact peaks have been deleted, Click File —
Click Save Project
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XI. Fusion Evidence Only - Exporting Electropherograms after

STRmix™ Analysis (samples only)

1. Inthe main analysis window, set the fixed X axis to 55-510 and set the Y axis to Auto Fit Y.
2. Click Tools—> Export Electropherogram
3. Set Output Folder to desired location for project PDFs by clicking J icon

Export Electrophercgrams , w

Output Folder: |M:"~STH_D atahid,_QCWAthena\201E6MAthena031416_10-11_2046-03-14% |

4.

5.

6.

7.

Ensure settings match below:

Select Dyes

| BLUE

w| GREEM

W YELLOW

v RED
ORAMGE

Dye Image Size

"wfidth: |'||:|24 pixels
| Height: |00 pixels

| Oneimage per zample
[v Auto Scale Size Range
[ Auto Scale Marker Intenzity

Ewport Format: |POF file -

In the suffix field enter the run name with a “_” before it followed by _SM (Ex:
Newton061316 88-89_SM) to indicate STRmix™ analysis.

I;rinting the samples only: Right click in the sample list = click Select All 2 Uncheck the

box for all ladders and controls in the run and any samples that were disabled or failed,
leaving only the passing samples = clear the prefix field = click Export. This will create 4
PDFs for every sample, one for each dye.

Import PDFs into LIMS.
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XII. Fusion Evidence Only - Exporting EVIDENCE table for
STRmix™ input

1. Inthe report display section of the main analysis screen, click on the report settings icon

£ .
. Make sure settings match below:

Allele Report Settings

Report Style
" Allele List

" Bin Tahble
" Peak Table

" Allele Count

[v Show File Mame

[ Show Sample Mame

Orientatiorn

i~ Honzontal f+ ertical

| Ewrchide Sample Indes

4

(]

Ophions |
L (
[ Extend Diploid Homozpgous |

v Show Allele Mame

[v Show Size [0.1bpz) ‘
[v Show Height |
| Show Area

-

Show Sigare

[ S !““ i

[ | Show Only Uneertair dleles

| [v Show Rejected Low Score Alleles
I Hide Extra Sample Marmes
T Eftiwde Feport Header

Ok Cancel

oo o

5. Click OK

6. Inthereport display section of the main analysis screen, click on the arrow of the Save

Report icon

= -

7. Click Save Report.
8. Navigate to appropriate folder and save file as type “Excel File (*.xlsx;*.xls)” under the
appropriate run name (make sure to delete suffix “_AlleleReport™). Click Save.
9. For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.
Open the exported project excel file from Step 1 above.
Open GeneMarker® to STRmix™ macro.
Follow the instructions on the “instructions” tab.
After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.
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Change the file type to “.txt” (Text, tab delimited)
Navigate to folder containing your project data and save file there.

XI11.Reporting Analyst/Case Tech Reviewer Sample Review

1. Review all STR runs associated with case file samples checking for:
i. Passing Allelic Ladder was used to analyze run
ii. Passing controls were present
iii. Passing Size Standard for relevant case file samples
iv. Appropriate edits were made for relevant case file' samples and edited peaks were
deleted
v. Any relevant samples needing re-run were'secheduled and/or disabled
2. Determine if sample is suitable for comparison/STRmiX™ analysis
3. Ifatrue OL/OB was detected in a sample the allele.must bg.assigned a call for STRmix™
i. Open STRmix™ .txt input file ahdweplace OL/OB call with true call
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HELPFUL ICONS INDEX
Main
Toolbarlcons
Icon Name Function
Run Opens Run Wizard for processing the data
2 Project '
Show/Hide | Allows user to show/hide the frames for the Sample File Tree, Synthetic
% @ B Toggles | Gel Image and Report Table, respectively:
Show Allows user the choice ofviewing/hiding all color lanes or single dye
= Color lane layer (with singlenleft mause click on the icon, obtain single dye
o - view)
Zoom Allows for more discriminate view of electropherogram. Alternately,
In/Zoom hold down left mouse button and draw a box; dragging from top left
corner to bottom right zooms in on image while dragging from bottom
@ Out
LY right'corner to top left zooms out.
Default sets Y-axis by maximum peak intensity for the sample
Set Axis displayed. The other 2 options either auto-fit the Y-axis by the peak
% intensity of the alleles displayed, or allow for setting the X- and Y- axes
ranges manually.
Browse b Allows for comparative view display of sample electropherograms by
All Colorz dye color. Individual samples can be selected from the drop down menu
g in the upper right corner of the All Color Browser display window.
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Allele Call Icons available after raw data processing only; Sample File Tree Allele Call folder must be selected

\ Icon Name Function
% Caliilsgtion Displays calibration charts for linearity of lane analysis.
Show Allows user to toggle the displaysto show only the Peak Table, the Peak
Chart/Table | Table and the Electropherogram,or,just'the Electropherogram.
Save Peak | Allows user to expart the Peak Table as an Excel(.xls) file or a tab-
Table delimited Text(.txt) file.
v
Allows user to call alleles by sample(s), by marker or by dyes. Allows
Call Allele AUser to make'some modifications to the threshold/filter settings without
having to activate' Run Wizard again (i.e. Peak Detection Threshold,
A Stutter Peak Filter and Peak Score Threshold).
Marker. |"N0n9" M Rlarksh Allows user to select a marker to view. Available after the samples have
Drop-<down
been compared to a Panel.
Menu
€ , . _
Event Log | Displays the processing success/failure of each dye lane.
<l VI:/Aiig:’% Activates the Start Your Project, Run and/or Report dialog boxes.
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Browse By All Colors Icons

\ Icon \ Name Function
® 0 Zoom
A In/Zoom | Same use as in the Main Analysis Screen.
Out
Show/Hide Allows user the option to showt/hide X= and Y- axis grid lines that
: Mouse he tip of th lohg withthe basepair si
b Cross appear at the tip of the mouse cursor along with'the basepair size
L . and RFU value of the mause cursepposition:
Lines
-,r\l“ Sho‘évi/:]_“de Allows userghe option to, show/hide the Bin brackets at the top and
- bottom ofithe electrepherogram.
Ranges
—— Allows usenthe option to adjust the RFU intensities of low peaks to
1A Auto Scale | match'the intensity of the highest peak in the dye color. When low
——— Markess,, | peaks are increased, the intensity magnification factor is noted in
the 'marker (can adjust from 2X to 8X).
=) Print Opens the Print Report settings box. Also accessible in the Main

Analysis screen.

Report Table I€ons locatedidirectly above the Report Table.

\ Icon \ Name Description
Siiﬁﬁ;ts Allows user to customize Report Table display settings.
=] Save Allows user to export the Report Table as an Excel (.xIs) file or tab-
o Report delimited Text (.txt) file.
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Cusé?rr]nize Allows user to select which bins to include/exclude in the Report Table

Column (check with TSL as this is not accessible at this time)

PEAK TABLE OPTIONS INDEX

Dye dye lane location of peak
Size peak basepair size (x-axis)
Height value given as relative frequency units (RFU) of the peak (y-axis)
Height Ratio p'\)/?::(kzrelght divided by height of highest peak in theddye lane®r
Area indicates the area under the curve of the peak; calculatedbased on x-
axis Start/End column settings
Area Ratio peak area divided by area of highest peak in the'dye lane or Marker
Marker locus location of the peak
Allele bin location of the peak (based®n Kit/system panel and ladder analysis
of project)
. absolute value of distance between the peak center and Bin center in
Difference .
basepairs
assigns Pass/Check/Undetermined quality ranking for each peak
Quality relativedo'the Allele Evaluation Peak Score settings in the Run
Wizard (see Additional Settings)
an‘exponentiakeurve based evaluation of the peak; calculation of the
Score value'igbased on signal-to-noise ratio and peak shape (or
morphology)
Start/End beginning and finish basepairs of the peak's Area calculation
Allele software and user edited comments for the peak; right mouse click
Comments peak in chart to add peak edit comments or select from the drop down
list (more in Edit Comments Index)
Sample user added comments for the sample; right mouse click sample name
P in the sample tree to add new sample edit comments or select from the
Comments . .
drop down list (more in Sample Comments Index)
Quality letter code abbreviation(s) of reason(s) for a peak 's Quality
Reasons assignment if ranked Check/Undetermined
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